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Phần A: DataPro Crypto Client

 

1. Giới thiệu 

DataPro Crypto là gì? 

DataPro Crypto là ứng dụng cung cấp dữ liệu giao dịch tiền điện tử theo thời gian thực. 
Ứng dụng tải xuống và lưu trữ dữ liệu giá, lịch sử giao dịch của các cặp tiền điện tử, hỗ 
trợ người dùng theo dõi và phân tích thị trường. 

Tính năng chính 

• Theo dõi giá tiền điện tử theo thời gian thực 

• Xem dữ liệu lịch sử theo ngày hoặc theo phút 

• Nhận thông báo từ hệ thống 

• Tích hợp với AmiBroker (trên Windows) 

• Cung cấp API cục bộ cho các công cụ bên ngoài 

Tại sao chọn DataPro Crypto? 

1. Tốc độ truy xuất cực nhanh Dữ liệu được lưu trữ local trên máy tính của bạn, giúp 
truy xuất tức thì không phụ thuộc vào độ trễ mạng. Đồng thời, dữ liệu vẫn được cập nhật 
realtime từ server. 

2. API đơn giản, không giới hạn RESTful API dễ sử dụng, không bị hạn chế bởi rate-
limit 3 requests/giây, số lượng subscriptions/giây hay giới hạn WebSocket như Binance 
API. 

3. Tài liệu API đầy đủ Hướng dẫn chi tiết với mô tả đầu vào/đầu ra, code mẫu Python 
sẵn sàng sử dụng. Hỗ trợ kết nối từ các ngôn ngữ lập trình khác theo yêu cầu. 

4. Dữ liệu tổng hợp sẵn Không cần lo lắng về việc lưu trữ hay xử lý dữ liệu thô. Sau 
thời gian dài không bật máy, DataPro Crypto tự động cập nhật đầy đủ dữ liệu gián đoạn 
chỉ trong tích tắc. 

5. Tích hợp AmiBroker Kết nối trực tiếp với phần mềm phân tích kỹ thuật AmiBroker 
quen thuộc thông qua plugin chuyên dụng. 

6. Đa nền tảng Hỗ trợ Windows, Linux và macOS - chạy trên mọi hệ điều hành phổ biến. 

7. Dữ liệu đa khung thời gian Cung cấp cả dữ liệu Daily (ngày) và Minute (phút) - phù 
hợp cho cả nhà đầu tư dài hạn và trader ngắn hạn. 

8. Tự động phục hồi Nếu máy tính tắt đột ngột, ứng dụng tự động kiểm tra và sửa chữa 
dữ liệu bị hỏng khi khởi động lại. 

9. Song ngữ Việt-Anh Giao diện hỗ trợ cả tiếng Việt và tiếng Anh, chuyển đổi chỉ với 1 
click. 

10. Dữ liệu lưu trữ an toàn Dữ liệu được lưu trữ an toàn trên máy tính của bạn, không 
lo mất dữ liệu khi có sự cố. 
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11. Chi phí hợp lý, hỗ trợ nhiệt tình Gói dịch vụ với mức giá phải chăng. Đội ngũ hỗ 
trợ sẵn sàng giải đáp mọi thắc mắc qua Zalo/điện thoại. 

Yêu cầu hệ thống 

Hệ điều 
hành 

Phiên bản Trạng thái 

Windows Windows 10/11 (32-bit và 64-bit) Đã phát hành 

Linux Ubuntu 20.04+ hoặc tương đương (32-bit và 64-bit) Sắp ra mắt 

macOS macOS 10.15+ (32-bit và 64-bit) Sắp ra mắt 

Yêu cầu khác:  

- Kết nối Internet ổn định  

- Tối thiểu 10GB dung lượng ổ cứng trống, ưu tiên SSD hoặc NVME  

- RAM tối thiểu 4GB 

Chi tiết cài đặt cho từng hệ điều hành xem tại Mục 2. Cài đặt và Khởi động. 

 

2. Cài đặt và Khởi động 

2.1. Tải xuống 

Truy cập website chính thức để tải file cài đặt: 

Website: https://datapro.vn 

https://datapro.vn/
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Hệ điều hành Trạng thái 

Windows (32-bit và 64-bit) Đã phát hành 

Linux Sắp ra mắt 

macOS Sắp ra mắt 

 

2.2. Cài đặt trên Windows 

Yêu cầu hệ thống 

• Windows 10 hoặc Windows 11 (32-bit và 64-bit) 

• Tối thiểu 500MB dung lượng ổ cứng trống 

• RAM tối thiểu 4GB 

• Kết nối Internet ổn định 

Các bước cài đặt 
1. Tải file cài đặt 

– Truy cập https://datapro.vn 

– Tải file cài đặt cho Windows 

2. Chạy file cài đặt 

– Mở file cài đặt vừa tải về 

– Nếu Windows SmartScreen hiển thị cảnh báo, nhấn More info → Run 
anyway 

https://datapro.vn/
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– Chọn Install for me only để cài đặt mà không cần quyền admin 

– Chọn Install for all users để cài cho toàn bộ người dùng (cần chạy với 
quyền admin)  

 
3. Chọn thư mục cài đặt 

– Chọn thư mục để cài đặt ứng dụng (mặc định: 
C:\Users\RPSoft\AppData\Local\DataPro\Crypto) 

– Nhấn Next để tiếp tục 

https://datapro.vn/
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– Tick vào ô “Don’t create a Start Menu folder” nếu không cần shortcut 
trong Start Menu. 

– Nhấn Next để tiếp tục 

 

– Tick vào ô “Create Desktop shortcut” để tạo icon ngoài màn hình 

– Tick vào ô “Create a Quick Launch shortcut” để tạo icon truy cập nhanh 
trên thanh công cụ 

– Nhấn Next để tiếp tục 

https://datapro.vn/
https://facebook.com/datapro.vn


 Tài liệu hướng dẫn sử dụng DataPro Crypto 

 

Zalo: 086-832-9247 https://datapro.vn https://facebook.com/datapro.vn 
Phiên bản tài liệu: 1.0 Cập nhật lần cuối: Tháng 1/2026 Copyright (c) datapro.vn 

11 / 46 

 

 

– Sau đó nhấn Install và đợi quá trình cài đặt hoàn tất thường sẽ mất 
khoảng 2-3s 

 

4. Hoàn tất cài đặt 

– Đợi quá trình cài đặt hoàn tất 

– Tích chọn Launch DataPro Crypto để khởi động ngay 

– Nhấn Finish 

https://datapro.vn/
https://facebook.com/datapro.vn


 Tài liệu hướng dẫn sử dụng DataPro Crypto 

 

Zalo: 086-832-9247 https://datapro.vn https://facebook.com/datapro.vn 
Phiên bản tài liệu: 1.0 Cập nhật lần cuối: Tháng 1/2026 Copyright (c) datapro.vn 

12 / 46 

 

 

2.3. Cài đặt trên Linux 

Thông báo: Phiên bản Linux đang được phát triển và sẽ sớm ra mắt. 

Yêu cầu hệ thống (dự kiến) 

• Ubuntu 20.04+ hoặc các bản phân phối tương đương (32-bit và 64-bit) 

• Tối thiểu 10GB dung lượng ổ cứng trống 

• RAM tối thiểu 4GB 

Hướng dẫn cài đặt (dự kiến) 

1. Tải file cài đặt cho Linux từ website 

2. Giải nén file vừa tải 

3. Cấp quyền thực thi cho file ứng dụng 

4. Chạy ứng dụng 

Vui lòng theo dõi website https://datapro.vn để cập nhật khi phiên bản Linux được phát 
hành. 

2.4. Cài đặt trên macOS 

Thông báo: Phiên bản macOS đang được phát triển và sẽ sớm ra mắt. 

Yêu cầu hệ thống (dự kiến) 

• macOS 10.15 (Catalina) trở lên 

• Chip Intel hoặc Apple Silicon (M1/M2/M3/M4) 

• Tối thiểu 10GB dung lượng ổ cứng trống 

• RAM tối thiểu 4GB 

https://datapro.vn/
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Hướng dẫn cài đặt (dự kiến) 

1. Tải file cài đặt cho macOS từ website 

2. Mở file DMG vừa tải 

3. Kéo biểu tượng DataPro Crypto vào thư mục Applications 

4. Mở ứng dụng từ Launchpad hoặc thư mục Applications 

Lưu ý: Lần đầu mở ứng dụng, macOS có thể yêu cầu xác nhận. Vào System 
Preferences → Security & Privacy và nhấn Open Anyway. 

Vui lòng theo dõi website https://datapro.vn để cập nhật khi phiên bản macOS được 
phát hành. 

2.5. Khởi động lần đầu 

Khi khởi động ứng dụng lần đầu tiên, bạn sẽ được yêu cầu: 

1. Chọn thư mục lưu dữ liệu 

– Ứng dụng sẽ đề xuất thư mục mặc định 

– Nhấn ĐỒNG Ý để sử dụng thư mục đề xuất 

– Nhấn KHÔNG để chọn thư mục khác 

  Lưu ý: Nên chọn ổ đĩa SSD có nhiều dung lượng trống vì dữ liệu sẽ được lưu 
trữ tại đây. 

 

2.6. Đăng ký tài khoản mới 

Nếu chưa có tài khoản, bạn có thể đăng ký trực tiếp trong ứng dụng: 

1. Tại màn hình đăng nhập, nhấn Đăng ký 

2. Điền đầy đủ thông tin: 

– Tên đăng nhập: Tên bạn sẽ sử dụng để đăng nhập 

– Họ và tên: Tên đầy đủ của bạn 

– Email: Địa chỉ email (dùng để kích hoạt tài khoản và khôi phục mật khẩu) 

– Số điện thoại: Số điện thoại liên hệ 

– Mật khẩu: Mật khẩu đăng nhập 

– Xác nhận mật khẩu: Nhập lại mật khẩu 

3. Nhấn ĐĂNG KÝ 

4. Nhập mã xác thực trong cửa sổ Captcha (xem mục 8.6) 

5. Sau khi đăng ký thành công, kiểm tra email để kích hoạt tài khoản 
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Quan trọng: Tài khoản chỉ có thể đăng nhập sau khi đã kích hoạt qua email. 
Vui lòng kiểm tra cả thư mục Spam/Junk nếu không thấy email trong hộp thư 
đến. 

2.7. Kiểm tra dữ liệu khi khởi động 

Khi khởi động, ứng dụng sẽ kiểm tra xem lần chạy trước có được đóng đúng cách hay 
không. 

Trường hợp đóng đúng cách: - Ứng dụng khởi động nhanh như bình thường 

Trường hợp đóng không đúng cách (mất điện, crash, tắt máy đột ngột…): 

- Ứng dụng sẽ kiểm tra toàn vẹn dữ liệu cho tất cả các file dữ liệu 

- Quá trình này hiển thị thông báo: “Đang kiểm tra cấu trúc: [tên file]” 

- Thời gian kiểm tra có thể lâu hơn bình thường tùy thuộc vào kích thước dữ liệu 

Nếu phát hiện file bị hỏng: 

- File hỏng sẽ được tự động xóa 

- Ứng dụng tải lại dữ liệu mới từ server để thay thế 

- Quá trình này hoàn toàn tự động, không cần thao tác từ người dùng 

Lưu ý: Để tránh mất dữ liệu hoặc phải kiểm tra lại, hãy luôn đóng ứng dụng 
đúng cách bằng nút Đăng xuất hoặc đóng cửa sổ thay vì tắt máy đột ngột. 

2.8. Đăng nhập 

1. Nhập Tên đăng nhập và Mật khẩu 

2. Tích chọn Lưu mật khẩu nếu muốn tự động đăng nhập lần sau 

3. Nhấn ĐĂNG NHẬP 

https://datapro.vn/
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Mẹo: Nhấn biểu tượng con mắt bên cạnh ô mật khẩu để hiện/ẩn mật khẩu. 

2.9. Quên mật khẩu 

Nếu quên mật khẩu: 

1. Tại màn hình đăng nhập, nhấn Quên mật khẩu? 

2. Nhập địa chỉ Email/Tài khoản đã đăng ký 

3. Nhấn GỬI để nhận email khôi phục mật khẩu 

 

3. Giao diện chính 

Sau khi đăng nhập thành công, bạn sẽ thấy giao diện chính của ứng dụng. 
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3.1. Thanh điều hướng (bên trái) 

Thanh điều hướng bao gồm các mục: 

Biểu tượng Tên Chức năng 

        Trang chủ Màn hình chính với hình nền 

      Dữ liệu Giá Xem bảng giá realtime 

    Dữ liệu Lịch sử Xem dữ liệu OHLCV 

     Tài khoản Quản lý thông tin cá nhân 

   Hỗ trợ Thông tin liên hệ hỗ trợ 

    Gia hạn Mua/gia hạn gói dịch vụ 

    Cài đặt Thiết lập ứng dụng 

      Đăng xuất Thoát tài khoản 

Mẹo: Nhấn vào logo DataPro để mở rộng/thu gọn thanh điều hướng. 

3.2. Thông tin người dùng (góc trên phải) 

Hiển thị thông tin tài khoản: 

• Người dùng: Tên đăng nhập 

• Họ và tên: Tên đầy đủ 

• Hết hạn: Ngày hết hạn dịch vụ và số ngày còn lại 

Màu sắc ngày hết hạn:  

-   Xanh lá: Đã hết hạn 

https://datapro.vn/
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-   Đỏ: Còn 0-2 ngày 

-   Hồng: Còn 3-6 ngày 

-    Xám: Còn 7+ ngày 

3.3. Chuyển đổi ngôn ngữ 

Nhấn nút VI hoặc EN ở góc trên phải để chuyển đổi giữa tiếng Việt và tiếng Anh. 

3.4. Thông báo 

Biểu tượng chuông     hiển thị số thông báo chưa đọc: 

• Nhấn vào chuông để xem danh sách thông báo nhanh 

• Nhấn Xem thêm… để mở trang thông báo đầy đủ 

• Thông báo chưa đọc có viền xanh bên trái 

3.5. Thanh trạng thái (phía dưới) 

Hiển thị trạng thái hệ thống: 

Biểu tượng Ý nghĩa 

    Cảnh báo - Nhấn 1 lần để tắt, nhấn 2 lần để mở log 

 
API đang chạy 

 
API đã tắt 

 
Đã kết nối server 

 
Mất kết nối server 

⬇️ B/s Tốc độ tải dữ liệu 

         m/s Tốc độ nhận tin nhắn 

       Số tin nhắn đang chờ được xử lý 

4. Dữ liệu Giá 

Màn hình Dữ liệu Giá hiển thị bảng giá tiền điện tử theo thời gian thực. 
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Loại trạng thái: 

– Đang giao dịch 

– Tạm dừng 

4.1. Thanh công cụ 

•     Làm mới: Tải lại dữ liệu thủ công 

• Lọc trạng thái: Chọn để lọc theo: 

– Đang giao dịch: Chỉ hiện mã đang giao dịch 

– Tạm dừng: Chỉ hiện mã tạm dừng 

– Toàn bộ: Hiện tất cả 

•        Tự động làm mới: Bật/tắt tự động cập nhật 

4.2. Bảng dữ liệu 

Cột tiếng anh Cột tiếng việt Giải thích 

Symbol Mã Mã tiền điện tử + trạng thái + tên 

Bid Vol KL Mua Khối lượng mua 

Bid Px Giá mua Giá mua tốt nhất 

Matched Vol KL Khớp Khối lượng khớp 

Close Đóng Giá đóng cửa/giá hiện tại 

Change Thay đổi Thay đổi giá (tuyệt đối) 

Δ% Δ% Thay đổi giá (phần trăm) 

Ask Px Giá Bán Giá bán tốt nhất 

Ask Vol KL Bán Khối lượng bán 

Open Mở Giá mở cửa 

https://datapro.vn/
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Cột tiếng anh Cột tiếng việt Giải thích 

High Cao Giá cao nhất trong ngày 

Low Thấp Giá thấp nhất trong ngày 

Trades GD Số lượng giao dịch 

Vol KL Tổng khối lượng giao dịch 

Val G.Trị Tổng giá trị giao dịch 

4.3. Màu sắc giá 

•   Xanh lá: Giá tăng 

•   Đỏ: Giá giảm 

•   Vàng: Không đổi 

Mẹo: Nhấn vào tiêu đề cột để sắp xếp theo cột đó. 

 

5. Dữ liệu Lịch sử 

Màn hình Dữ liệu Lịch sử cho phép xem dữ liệu OHLCV (Open, High, Low, Close, 
Volume) , ...  trong quá khứ. 

 

5.1. Bộ lọc 

1.     Làm mới: Tải lại dữ liệu 

2. Loại dữ liệu: 

– Ngày: Dữ liệu theo ngày 

– 1 phút: Dữ liệu theo từng phút 

3. Khoảng thời gian: 

https://datapro.vn/
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– 3 ngày 

– 1 tuần 

– 1 tháng 

– 6 tháng 

– 1 năm 

– Toàn bộ 

4. Tìm mã: Nhập tên mã để tìm kiếm 

– Danh sách gợi ý sẽ hiện ra khi bạn gõ 

– Chọn mã từ danh sách để xem dữ liệu 

5.2. Bảng dữ liệu lịch sử 

Cột tiếng anh Cột tiếng việt Giải thích 

Trading Time Thời gian  Thời gian giao dịch 

Open Mở Giá mở cửa 

High Cao Giá cao nhất 

Low Thấp Giá thấp nhất 

Close Đóng Giá đóng cửa 

Change Thay đổi Thay đổi giá 

Δ% Δ% Thay đổi phần trăm 

Trades GD Số giao dịch 

Vol KL Khối lượng 

Val G.Trị Giá trị 

Buy Vol KL Mua Khối lượng mua 

Buy Val G.Trị Mua Giá trị mua 

 

6. Thông báo 

6.1. Xem thông báo nhanh 

Nhấn vào biểu tượng chuông     để xem popup thông báo: 

• Thông báo chưa đọc có viền xanh bên trái 

• Biểu tượng      cho thông báo được ghim 

• Hiển thị tiêu đề và thời gian 

• Nhấn vào thông báo để xem chi tiết 
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6.2. Trang thông báo 

Nhấn “Xem thêm…” trong popup: 

 

Các thành phần: 

1. Bộ lọc loại thông báo: Chọn để lọc theo loại 

– Toàn bộ 

– Theo từng loại thông báo cụ thể 

2. Danh sách thông báo: 

– Thông báo được sắp xếp theo thứ tự thời gian (mới nhất hiển thị trước) 

– Viền xanh = chưa đọc 

– Hiển thị tiêu đề, mã loại, thời gian 

3. Phân trang: 

– ⏮ Trang đầu 

– ◀ Trang trước 
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– Số trang hiện tại / Tổng số trang 

– ▶ Trang sau 

– ⏭ Trang cuối 

6.3. Xem chi tiết thông báo 

Nhấn vào thông báo bất kỳ để mở cửa sổ chi tiết: 

• Hiển thị tiêu đề đầy đủ 

• Nội dung HTML với định dạng 

• Có thể nhấn vào các liên kết trong nội dung 

 

7. Quản lý Tài khoản 

7.1. Xem thông tin tài khoản 

Từ menu bên trái, nhấn Tài khoản: 
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Thông tin hiển thị:  

- Tên đăng nhập  

- Họ và tên  

- Email  

- Ngày hết hạn dịch vụ 

Các nút:  

- ĐỔI MẬT KHẨU: Mở cửa sổ đổi mật khẩu  

- CẬP NHẬT: Tải lại thông tin từ server  

- ĐÓNG: Đóng cửa sổ 

7.2. Đổi mật khẩu 

1. Trong cửa sổ Tài khoản, nhấn ĐỔI MẬT KHẨU 

2. Nhập Mật khẩu hiện tại 

3. Nhập Mật khẩu mới 

4. Nhập lại Xác nhận mật khẩu mới 

5. Nhấn ĐỔI MẬT KHẨU để xác nhận 
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Lưu ý: Mật khẩu nên có ít nhất 8 ký tự, bao gồm chữ hoa, chữ thường và số. 

8. Gia hạn Dịch vụ 

8.1. Quy trình gia hạn 

Khi nhấn Gia hạn Dịch vụ từ menu bên trái: 

• Nếu chưa có đơn hàng đang chờ xử lý: Hiển thị cửa sổ tạo đơn hàng mới 

• Nếu đã có đơn hàng đang chờ xử lý: Hiển thị chi tiết đơn hàng đó 

Lưu ý: Hệ thống chỉ cho phép tồn tại 1 đơn hàng đang chờ xử lý tại một thời 
điểm. Bạn cần hủy hoặc hoàn tất đơn hàng hiện tại trước khi tạo đơn mới. 
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8.2. Tạo đơn hàng mới 

 

1. Chọn Gói dịch vụ từ danh sách 

2. Xem thông tin gói: 

– Số ngày: Thời hạn sử dụng 

– Số tiền (VNĐ): Giá gốc gói dịch vụ 

3. Nhập Mã khuyến mãi (nếu có) 

– Có thể là tài khoản người giới thiệu hoặc mã khuyến mãi 

4. Nhập Ghi chú (tùy chọn) 

5. Nhấn XÁC NHẬN 

6. Nhập mã xác thực trong cửa sổ Captcha (xem mục 8.6) 

Sau khi tạo đơn thành công, cửa sổ Chi tiết đơn hàng sẽ tự động hiển thị. 

8.3. Chi tiết đơn hàng 

Khi có đơn hàng đang chờ xử lý hoặc sau khi tạo đơn mới, cửa sổ chi tiết đơn hàng sẽ 
hiển thị: 
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Thông tin hiển thị: 

Trường Mô tả 

Mã đơn hàng Mã định danh đơn hàng 

Trạng thái - PENDING (chờ xử lý) 

- ADVANCED (tạm ứng) 

- APPROVED (hoàn tất) 

- CANCELLED (đã hủy) 

Gói dịch vụ Tên gói đã chọn 

Số ngày Số ngày sử dụng của gói 

Giá gốc (VNĐ) Giá trước khuyến mãi 

Số tiền thanh toán (VNĐ) Giá sau khuyến mãi (nếu có) 

Mã khuyến mãi Mã đã áp dụng (nếu có) 

Ngày tạo Thời gian tạo đơn 

Ngày xử lý Thời gian xử lý (sau khi thanh toán) 

Ngày hết hạn hiện tại Ngày hết hạn trước khi gia hạn 

Ngày hết hạn mới Ngày hết hạn sau khi gia hạn 

Các nút thao tác: 

Nút Chức năng 

THANH TOÁN Xem hướng dẫn thanh toán (chuyển khoản, QR code…) 

HỦY ĐƠN Hủy đơn hàng (chỉ hiển thị khi đơn đang chờ xử lý) 

OK Đóng cửa sổ 
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8.4. Thanh toán 

1. Trong cửa sổ Chi tiết đơn hàng, nhấn THANH TOÁN 

2. Cửa sổ hướng dẫn thanh toán sẽ hiển thị với thông tin: 

– Số tài khoản ngân hàng 

– Nội dung chuyển khoản 

– Mã QR (nếu có) 

3. Thực hiện chuyển khoản theo hướng dẫn 

4. Đơn hàng sẽ được xử lý sau khi xác nhận thanh toán 

8.5. Hủy đơn hàng 

Nếu muốn hủy đơn hàng đang chờ xử lý: 

1. Trong cửa sổ Chi tiết đơn hàng, nhấn HỦY ĐƠN 

2. Xác nhận hủy trong hộp thoại 

3. Sau khi hủy, bạn có thể tạo đơn hàng mới 

Lưu ý: Chỉ có thể hủy đơn hàng ở trạng thái PENDING hoặc ADVANCED. 
Không thể hủy đơn đã hoàn tất thanh toán. 

8.6. Cửa sổ xác thực (Captcha) 

Một số thao tác quan trọng như tạo đơn hàng, đăng ký, đổi mật khẩu… yêu cầu nhập mã 
xác thực để đảm bảo an toàn. 

 

Các thành phần: 

Thành phần Mô tả 

Hình ảnh captcha Hình chứa 4 ký tự cần nhập 

Nút làm mới (↻) Tải hình captcha mới 

4 ô nhập liệu Nhập lần lượt 4 ký tự từ hình 

Đồng hồ đếm ngược Thời gian còn lại trước khi hết hạn 

Thời gian hết hạn: 

• Mỗi mã captcha có hiệu lực trong 5 phút (05:00) 

• Đồng hồ đếm ngược hiển thị thời gian còn lại (MM:SS) 
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• Khi còn dưới 60 giây, đồng hồ chuyển sang màu đỏ để cảnh báo 

• Khi hết thời gian, hình captcha tự động làm mới và đồng hồ đếm lại từ 05:00 

Cách nhập: 

1. Xem hình captcha và nhận diện 4 ký tự (chữ hoặc số) 

2. Nhập từng ký tự vào 4 ô tương ứng 

3. Con trỏ tự động chuyển sang ô tiếp theo sau khi nhập 

4. Nhấn XÁC NHẬN hoặc phím Enter để gửi 

Phím tắt: 

Phím Chức năng 

Enter Xác nhận mã đã nhập 

ESC Hủy và đóng cửa sổ 

← → Di chuyển giữa các ô nhập 

Backspace Xóa và quay lại ô trước 

Xử lý khi không đọc được: 

• Nếu hình khó đọc, nhấn nút ↻ để tải hình mới 

• Đồng hồ sẽ được đặt lại về 05:00 khi làm mới 

Lưu ý: Mã captcha không phân biệt chữ hoa/chữ thường. Ví dụ: nhập “abcd” 
hoặc “ABCD” đều được chấp nhận. 

 

9. Cài đặt 

Từ menu bên trái, nhấn Cài đặt để mở cửa sổ thiết lập. 
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9.1. Cài đặt API 

• Bật API: Tích chọn để bật API cục bộ 

• Cổng API: Nhập số cổng (mặc định: 5000) 

Lưu ý: Tính năng API chỉ khả dụng cho tài khoản đã mua gói dịch vụ (không áp 
dụng cho tài khoản dùng thử). 

API cho phép các công cụ bên ngoài truy cập dữ liệu qua địa chỉ 
http://localhost:5000/api/. Xem chi tiết tại Phụ lục: Hướng dẫn sử dụng 
API. 

9.2. Thư mục dữ liệu 

• Thư mục lưu dữ liệu: Đường dẫn lưu trữ dữ liệu 

• Nhấn Chọn… để chọn thư mục khác 

9.3. Plugin AmiBroker (chỉ Windows) 

Nếu sử dụng AmiBroker: 

• Thư mục plugin: Đường dẫn thư mục Plugins của AmiBroker 

– Mặc định: C:\Program Files\AmiBroker\Plugins 

• Kiến trúc: Chọn phiên bản plugin 

– 32-bit: Cho AmiBroker 32-bit 

– 64-bit: Cho AmiBroker 64-bit (mặc định) 

Tự động cập nhật Plugin: 

Khi khởi động ứng dụng, plugin sẽ được tự động cập nhật lên phiên bản mới nhất nếu 
có. Quá trình này diễn ra hoàn toàn tự động và không cần thao tác từ người dùng. 

• Cập nhật chỉ thành công nếu tất cả AmiBroker đã đóng 
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• Nếu AmiBroker đang chạy, việc cập nhật sẽ được bỏ qua 

• Bạn có thể cập nhật thủ công trong phần Các thao tác bảo trì bên dưới 

Mẹo: Để đảm bảo plugin luôn được cập nhật, hãy đóng AmiBroker trước khi 
khởi động DataPro Crypto. 

9.4. Các thao tác bảo trì 

Nút Chức năng 

CẬP NHẬT PLUGIN Tải và cài đặt plugin AmiBroker mới nhất 

KHỞI TẠO LẠI DỮ LIỆU     Xóa và tải lại dữ liệu (xem chi tiết bên dưới) 

LẤY LẠI TÊN Cập nhật tên các mã tiền điện tử từ server 

Khởi tạo lại dữ liệu 

Khi nhấn KHỞI TẠO LẠI DỮ LIỆU, một cửa sổ popup sẽ hiện ra cho phép bạn chọn loại 
dữ liệu cần khởi tạo lại: 

 

Nút Chức năng 

DAILY Chỉ khởi tạo lại dữ liệu theo ngày 

INTRADAY Chỉ khởi tạo lại dữ liệu theo phút 

TẤT CẢ Khởi tạo lại toàn bộ dữ liệu (cả ngày và phút) 

HỦY Hủy thao tác, không khởi tạo lại 

Cảnh báo: Thao tác khởi tạo lại sẽ xóa dữ liệu đã lưu của loại được chọn và tải 
lại từ đầu. Quá trình này có thể mất vài phút tùy thuộc vào tốc độ mạng. Chỉ 
thực hiện khi cần thiết. 

9.5. Lưu cài đặt 

• Nhấn LƯU để lưu thay đổi 

• Nhấn ĐÓNG để hủy và đóng cửa sổ 

 

10. Hỗ trợ 

Từ menu bên trái, nhấn Hỗ trợ để xem thông tin liên hệ: 
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Các kênh hỗ trợ 

Kênh Thông tin 

       Điện thoại / Zalo 086-832-9247 

  Website https://datapro.vn 

     Facebook https://facebook.com/datapro.vn 

     Hướng dẫn crypto.pdf 

Mẹo: Nhấn vào biểu tượng sao chép bên cạnh mỗi thông tin để copy nhanh. 

 

11. Phụ lục 

11.1. Bảng mã màu 

Màu sắc giá: 

Màu Ý nghĩa 

  Xanh lá (#90EE90) Giá tăng 

  Đỏ Giá giảm 

  Vàng Không đổi 

Màu sắc ngày hết hạn: 

https://datapro.vn/
https://facebook.com/datapro.vn


 Tài liệu hướng dẫn sử dụng DataPro Crypto 

 

Zalo: 086-832-9247 https://datapro.vn https://facebook.com/datapro.vn 
Phiên bản tài liệu: 1.0 Cập nhật lần cuối: Tháng 1/2026 Copyright (c) datapro.vn 

32 / 46 

 

Màu Số ngày còn lại 

  Xanh lá Đã hết hạn 

  Đỏ 0-2 ngày 

  Hồng 3-6 ngày 

   Xám 7+ ngày 

Màu sắc thông báo: 

Màu viền Ý nghĩa 

  Xanh dương Chưa đọc 

Không viền Đã đọc 

11.2. Phím tắt 

Chung: 

Phím Chức năng 

ESC Quay về Trang chủ / Đóng cửa sổ con 

Trong cửa sổ Captcha: 

Phím Chức năng 

Enter Xác nhận mã captcha 

ESC Hủy và đóng 

← → Di chuyển giữa các ô nhập 

Backspace Xóa và quay lại ô trước 

11.3. Vị trí lưu trữ dữ liệu 

Hệ điều hành Thư mục mặc định 

Windows [Ổ đĩa có nhiều dung lượng nhất]\CryptoData\ 

Linux ~/.local/share/CryptoData/ 

macOS ~/Library/Application Support/CryptoData/ 

11.4. Xử lý sự cố thường gặp 

Không đăng nhập được 

1. Kiểm tra kết nối Internet 

2. Kiểm tra tên đăng nhập và mật khẩu 

3. Thử tắt VPN nếu đang sử dụng 

4. Liên hệ hỗ trợ nếu vẫn không được 

Mất kết nối server 

1. Kiểm tra biểu tượng trạng thái ở thanh dưới 

2. Ứng dụng sẽ tự động kết nối lại 
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3. Nếu không tự kết nối, thử đăng xuất và đăng nhập lại 

Dữ liệu không cập nhật 

1. Nhấn nút     Làm mới trên màn hình dữ liệu 

2. Kiểm tra kết nối server 

3. Vào Cài đặt → KHỞI TẠO LẠI DỮ LIỆU nếu cần 

Plugin AmiBroker không hoạt động 

1. Đảm bảo đã đóng AmiBroker trước khi cập nhật plugin 

2. Kiểm tra đường dẫn thư mục plugin trong Cài đặt 

3. Chọn đúng kiến trúc (32-bit hoặc 64-bit) phù hợp với phiên bản AmiBroker 

4. Nhấn CẬP NHẬT PLUGIN trong Cài đặt 

Ứng dụng chạy chậm 

1. Kiểm tra dung lượng ổ cứng còn trống 

2. Thử khởi động lại ứng dụng 

3. Nếu vẫn chậm, thử KHỞI TẠO LẠI DỮ LIỆU 

Khởi động lâu hơn bình thường 

Nếu lần trước ứng dụng bị đóng không đúng cách (mất điện, crash…): 1. Ứng dụng sẽ tự 
động kiểm tra toàn vẹn dữ liệu 2. Quá trình này mất thêm thời gian - hãy kiên nhẫn chờ 
đợi 3. Nếu phát hiện file hỏng, dữ liệu sẽ được tải lại tự động 4. Để tránh tình trạng này, 
luôn đóng ứng dụng đúng cách 

11.5. Hướng dẫn sử dụng API (Local API) 

Yêu cầu: Tính năng API chỉ khả dụng cho tài khoản đã mua gói dịch vụ (không áp dụng 
cho tài khoản dùng thử). 

Khi bật API trong Cài đặt, ứng dụng cung cấp REST API tại 
http://localhost:{port}/api/ cho phép các công cụ bên ngoài truy cập dữ liệu. 

Thông tin chung 

• Base URL: http://localhost:5000/api/ (port mặc định là 5000) 

• Method: Chỉ hỗ trợ GET 

• Response Format: text/plain, text/csv, hoặc application/json 

• Encoding: UTF-8 

Danh sách Endpoint 

1. Ping - Kiểm tra kết nối 
GET /api/ping 

Response: Unix timestamp (giây) 

Ví dụ response: 

1704067200
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2. Info - Thông tin giá 
GET /api/info 
GET /api/info/{symbol} 

Tham số: - symbol (tùy chọn): Mã tiền điện tử (VD: BTC). Nếu không truyền, trả về tất cả. 

Response: CSV với các cột: 

Cột Mô tả 

Symbol Mã giao dịch 

StatusCode Trạng thái (TRADING, BREAK) 

OpenPx Giá mở cửa 

HighPx Giá cao nhất 

LowPx Giá thấp nhất 

ClosePx Giá đóng cửa/hiện tại 

RefPx Giá tham chiếu 

TradeCount Số giao dịch 

Name Tên đầy đủ 

MatchedVol Khối lượng khớp 

Vol Tổng khối lượng 

QuoteVol Khối lượng quote 

BidVol Khối lượng mua 

BidPx Giá mua tốt nhất 

AskVol Khối lượng bán 

AskPx Giá bán tốt nhất 

Ví dụ response: 

Symbol,StatusCode,OpenPx,HighPx,LowPx,ClosePx,RefPx,TradeCount,Name,Matche
dVol,Vol,QuoteVol,BidVol,BidPx,AskVol,AskPx 
BTC,TRADING,42150.5,42500.0,41800.0,42350.25,42150.5,125000,Bitcoin,1500.5
,2500.75,105000000,50.25,42349.5,30.15,42351.0

 

3. Trade - Giao dịch gần đây 
GET /api/trade/{symbol}/{depth} 

Tham số:  

- symbol (bắt buộc): Mã tiền điện tử (VD: BTC)  

- depth (bắt buộc): Số lượng giao dịch (1-1000) 

Response: CSV với các cột: 
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Cột Mô tả 

ID Mã giao dịch 

PX Giá 

QTY Khối lượng 

QUOTE_QTY Giá trị quote 

TIME Thời gian (Unix milliseconds) 

IS_BUYER_MAKER Người mua là maker 

IS_BEST_MATCH Khớp giá tốt nhất 

Ví dụ response: 

ID,PX,QTY,QUOTE_QTY,TIME,IS_BUYER_MAKER,IS_BEST_MATCH 
123456789,42350.50,0.5,21175.25,1704067200000,False,True 
123456790,42351.00,0.25,10587.75,1704067201000,True,True 

 

4. Book - Sổ lệnh 
GET /api/book/{symbol}/{depth} 

Tham số:  

- symbol (bắt buộc): Mã tiền điện tử (VD: BTC)  

- depth (bắt buộc): Độ sâu sổ lệnh. Giá trị hợp lệ: 5, 10, 20, 50, 100, 500, 1000, 5000 

Response: CSV với các cột: 

Cột Mô tả 

SIDE Loại lệnh (bid = mua, ask = bán) 

PX Giá 

VOL Khối lượng 

Ví dụ response: 

SIDE,PX,VOL 
bid,42349.50,1.5 
bid,42348.00,2.3 
bid,42347.50,0.8 
ask,42351.00,1.2 
ask,42352.50,3.1 
ask,42353.00,0.5

 

5. Hist - Dữ liệu lịch sử 
GET /api/hist/{symbol}/{datatype} 
GET /api/hist/{symbol}/{datatype}/{fromtime} 
GET /api/hist/{symbol}/{datatype}/{fromtime}/{totime} 

Tham số:  
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- symbol (bắt buộc): Mã tiền điện tử (VD: BTC) 

- datatype (bắt buộc): Loại dữ liệu. Giá trị hợp lệ: d, m 

- fromtime (tùy chọn): Thời gian bắt đầu (Unix timestamp). Mặc định: 0 (từ đầu)  

- totime (tùy chọn): Thời gian kết thúc (Unix timestamp). Mặc định: 0 (đến cuối) 

Quy tắc thời gian:  

- fromtime = 0: Lấy từ đầu (không giới hạn dưới)  
- totime = 0: Lấy đến cuối (không giới hạn trên)  
- Nếu totime > 0 thì totime phải lớn hơn fromtime 

Response: CSV với các cột: 

Cột Mô tả 

TRADING_TIME Thời gian (Unix timestamp) 

TRADE_COUNT Số lượng giao dịch 

OPEN_PX Giá mở cửa 

HIGH_PX Giá cao nhất 

LOW_PX Giá thấp nhất 

CLOSE_PX Giá đóng cửa 

VOL Khối lượng giao dịch 

QUOTE_VOL Khối lượng báo giá 

BUY_VOL Khối lượng mua 

BUY_QUOTE_VOL Khối lượng báo giá mua 

REF_PX Giá tham chiếu 

Ví dụ response: 

TRADING_TIME,TRADE_COUNT,OPEN_PX,HIGH_PX,LOW_PX,CLOSE_PX,VOL,QUOTE_VOL,BUY
_VOL,BUY_QUOTE_VOL,REF_PX 
1704067200,1234,42000.50,42500.00,41800.00,42350.00,150.5,6320100.25,75.2,
3160050.12,42000.00 
1704153600,2156,42350.00,43000.00,42100.00,42800.00,200.8,8593440.00,110.5
,4730900.00,42350.00 

Mã lỗi HTTP 

Mã Ý nghĩa 

200 Thành công 

400 Tham số không hợp lệ 

404 Không tìm thấy (endpoint không tồn tại hoặc 
không có dữ liệu cho symbol) 

405 Method không được hỗ trợ (chỉ GET) 

429 Rate limit - cần chờ trước khi gọi tiếp 
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Mã Ý nghĩa 

500 Lỗi server 

503 Không thể kết nối nguồn dữ liệu 

Response khi bị rate limit (429): 

{"error": "Rate limited. Wait 60000ms.", "waitMs": 60000} 

 

Ví dụ Python 

Cài đặt thư viện 
pip install requests pandas 

Kiểm tra kết nối 
import requests 
 
BASE_URL = "http://localhost:5000/api" 
 
def ping(): 
    response = requests.get(f"{BASE_URL}/ping") 
    if response.status_code == 200: 
        print(f"Server time: {response.text}") 
        return True 
    return False 
 
ping() 

Lấy thông tin giá tất cả mã 
import requests 
import pandas as pd 
from io import StringIO 
 
BASE_URL = "http://localhost:5000/api" 
 
def get_all_quotes(): 
    response = requests.get(f"{BASE_URL}/info") 
    if response.status_code == 200: 
        df = pd.read_csv(StringIO(response.text)) 
        return df 
    return None 
 
# Lấy và hiển thị dữ liệu 
df = get_all_quotes() 
if df is not None: 
    print(df.head(10)) 
    print(f"\nTổng số mã: {len(df)}") 

Lấy thông tin một mã cụ thể 
import requests 
import pandas as pd 
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from io import StringIO 
 
BASE_URL = "http://localhost:5000/api" 
 
def get_quote(symbol): 
    response = requests.get(f"{BASE_URL}/info/{symbol}") 
    if response.status_code == 200: 
        df = pd.read_csv(StringIO(response.text)) 
        if len(df) > 0: 
            return df.iloc[0].to_dict() 
    return None 
 
# Lấy thông tin BTC 
btc = get_quote("BTC") 
if btc: 
    print(f"Symbol: {btc['Symbol']}") 
    print(f"Giá hiện tại: {btc['ClosePx']}") 
    print(f"Cao nhất: {btc['HighPx']}") 
    print(f"Thấp nhất: {btc['LowPx']}") 

Lấy giao dịch gần đây 
import requests 
import pandas as pd 
from io import StringIO 
 
BASE_URL = "http://localhost:5000/api" 
 
def get_recent_trades(symbol, depth=100): 
    response = requests.get(f"{BASE_URL}/trade/{symbol}/{depth}") 
    if response.status_code == 200: 
        df = pd.read_csv(StringIO(response.text)) 
        # Chuyển đổi thời gian 
        df['TIME'] = pd.to_datetime(df['TIME'], unit='ms') 
        return df 
    elif response.status_code == 429: 
        # Rate limited 
        data = response.json() 
        print(f"Rate limited! Chờ {data['waitMs']}ms") 
    return None 
 
# Lấy 50 giao dịch gần nhất của BTC 
trades = get_recent_trades("BTC", 50) 
if trades is not None: 
    print(trades.head()) 

Lấy sổ lệnh 
import requests 
import pandas as pd 
from io import StringIO 
 
BASE_URL = "http://localhost:5000/api" 
 

https://datapro.vn/
https://facebook.com/datapro.vn


 Tài liệu hướng dẫn sử dụng DataPro Crypto 

 

Zalo: 086-832-9247 https://datapro.vn https://facebook.com/datapro.vn 
Phiên bản tài liệu: 1.0 Cập nhật lần cuối: Tháng 1/2026 Copyright (c) datapro.vn 

39 / 46 

 

def get_order_book(symbol, depth=20): 
    response = requests.get(f"{BASE_URL}/book/{symbol}/{depth}") 
    if response.status_code == 200: 
        df = pd.read_csv(StringIO(response.text)) 
        bids = df[df['SIDE'] == 'bid'].copy() 
        asks = df[df['SIDE'] == 'ask'].copy() 
        return bids, asks 
    return None, None 
 
# Lấy sổ lệnh BTC 
bids, asks = get_order_book("BTC", 10) 
if bids is not None: 
    print("=== LỆNH MUA (BID) ===") 
    print(bids[['PX', 'VOL']]) 
    print("\n=== LỆNH BÁN (ASK) ===") 
    print(asks[['PX', 'VOL']]) 

Xử lý Rate Limit 
import requests 
import time 
 
BASE_URL = "http://localhost:5000/api" 
 
def safe_request(url, max_retries=3): 
    for attempt in range(max_retries): 
        response = requests.get(url) 
 
        if response.status_code == 200: 
            return response.text 
        elif response.status_code == 429: 
            data = response.json() 
            wait_seconds = data['waitMs'] / 1000 
            print(f"Rate limited. Chờ {wait_seconds}s...") 
            time.sleep(wait_seconds) 
        else: 
            print(f"Lỗi: {response.status_code}") 
            return None 
 
    return None 
 
# Sử dụng 
result = safe_request(f"{BASE_URL}/trade/BTC/100") 

 

Phần B: DataPro Crypto Plugin (AmiBroker) 
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12. Giới thiệu Plugin 

DataPro.Crypto Plugin là plugin dữ liệu cho phần mềm AmiBroker, cung cấp dữ liệu 
giao dịch cryptocurrency real-time từ ứng dụng DataPro.Crypto.Client. 

Thông tin Chi tiết 

Tên plugin DataPro.Crypto Plugin 

Phiên bản 1.0.0.1 

Nhà phát triển datapro.vn 

Website https://datapro.vn 

Facebook https://facebook.com/datapro.vn 

Tính năng chính:  

- Dữ liệu Daily (End-of-Day) và Minute (Intraday)  

- Cập nhật real-time với streaming quotes  

- Hỗ trợ tối đa 100 symbols cùng lúc  

- Tùy chỉnh trường dữ liệu phụ (Aux fields) 

 

13. Yêu cầu hệ thống Plugin 
• Hệ điều hành: Windows (32-bit hoặc 64-bit) 

• AmiBroker: Phiên bản 5.27 trở lên 

• DataPro.Crypto.Client: Đã cài đặt và đang chạy 

• Giới hạn: Tối đa 100 symbols trong real-time quote cùng lúc 

 

14. Cài đặt Plugin 

14.1. Copy file plugin 

Copy file datapro.crypto.dll vào thư mục Plugins của AmiBroker: 

Phiên bản AmiBroker Đường dẫn 

32-bit C:\Program Files (x86)\AmiBroker\Plugins\ 

64-bit C:\Program Files\AmiBroker\Plugins\ 

https://datapro.vn/
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Lưu ý: Plugin có thể được cập nhật tự động từ DataPro.Crypto.Client khi khởi 
động (xem mục 9.3). 

14.2. Khởi động lại AmiBroker 

Đóng và mở lại AmiBroker để plugin được nhận diện. 

14.3. Tạo database mới 

1. Vào menu File → New → Database… 

2. Chọn thư mục lưu database 

3. Trong Data Source, chọn DataPro.Crypto Plugin 

4. Chọn Base time interval phù hợp (Daily hoặc 1-minute) 

5. Nhấn OK 

https://datapro.vn/
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15. Cấu hình Plugin 

Mở cửa sổ cấu hình: File → Database Settings → Configure 
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15.1. Chế độ làm mới dữ liệu (Auto Refresh) 

Chế độ Tần suất Mô tả 

Fast 300ms Cập nhật nhanh nhất, phù hợp scalping. Tốn nhiều CPU. 

Normal 800ms Mặc định. Cân bằng giữa tốc độ và hiệu suất. 

Idle 5000ms Tiết kiệm CPU nhất, phù hợp phân tích dài hạn. 

15.2. Cấu hình trường dữ liệu 

Plugin cho phép tùy chỉnh 3 trường dữ liệu phụ cho cả Daily và Minute: 

Trường Mô tả 

OI Open Interest - Trường mở rộng 1 

Aux1 Auxiliary Data 1 - Trường mở rộng 2 

Aux2 Auxiliary Data 2 - Trường mở rộng 3 

Các giá trị có thể chọn: 

Giá trị Mô tả 

Quote_Vol Khối lượng báo giá 

Buy_Vol Khối lượng mua 

Buy_Quote_Vol Khối lượng báo giá mua 

Trade_Count Số lượng giao dịch 

Mặc định:  

- OI: Quote_Vol  

- Aux1: Buy_Vol  

- Aux2: Buy_Quote_Vol 

15.3. Các nút chức năng 

Nút Chức năng 

Save Lưu cấu hình vào Registry 

Reset Default Khôi phục cài đặt mặc định 

Retrieve Symbols Lấy danh sách symbols từ database vào AmiBroker 

 

16. Sử dụng Plugin 

16.1. Thanh trạng thái 

Plugin hiển thị “DP.Crpt” trên thanh trạng thái AmiBroker (góc dưới bên phải). 

Ý nghĩa màu sắc: 
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Màu Trạng thái Mô tả 

Xanh lá OK Hoạt động bình thường, đã kết nối với 
DataPro.Crypto.Client 

Vàng Cảnh báo DataPro.Crypto.Client chưa chạy 

Xanh dương Lỗi nhẹ Có lỗi xảy ra, cần kiểm tra cài đặt 

Đỏ/Tím Lỗi nghiêm trọng Lỗi nghiêm trọng, xem chi tiết trong tooltip 

 

 

Xem chi tiết: Di chuột vào thanh trạng thái để xem thông báo đầy đủ. 

16.2. Menu chuột phải 

Click chuột phải vào thanh trạng thái plugin để mở menu: 

Menu Chức năng 

Configure Mở cửa sổ cấu hình 

Reload Tải lại dữ liệu cho symbol đang xem 

Reload All Tải lại dữ liệu cho tất cả symbols đã được truy cập. 

Lưu ý: Chỉ các symbols đã từng mở mới được tải lại! Để đảm bảo tải 
lại toàn bộ dữ liệu, hãy sử dụng chức năng Scan/Explore của 
AmiBroker. 

Auto Refresh Thay đổi chế độ làm mới (Fast/Normal/Idle) 

Clear Warning Xóa thông báo cảnh báo 

About DataPro Hiển thị thông tin về plugin 

 

https://datapro.vn/
https://facebook.com/datapro.vn


 Tài liệu hướng dẫn sử dụng DataPro Crypto 

 

Zalo: 086-832-9247 https://datapro.vn https://facebook.com/datapro.vn 
Phiên bản tài liệu: 1.0 Cập nhật lần cuối: Tháng 1/2026 Copyright (c) datapro.vn 

45 / 46 

 

16.3. Cửa sổ Real-Time Quote 

Vào menu Window → Real-Time Quote để xem báo giá real-time của các symbols. 

Thông tin hiển thị:  

- Giá Last, Open, High, Low  

- Khối lượng giao dịch  

- Thay đổi giá trong ngày  

- Bid/Ask (nếu có) 

 

16.4. Hộp thoại About 

Click chuột phải vào thanh trạng thái → chọn About DataPro để xem thông tin plugin. 

 

 

17. Khắc phục sự cố Plugin 

17.1. Bảng tra cứu lỗi 

Trạng thái Nguyên nhân Giải pháp 

Thanh trạng thái màu 
vàng 

DataPro.Crypto.Client 
chưa chạy 

Khởi động ứng dụng 
DataPro.Crypto.Client 

Thanh trạng thái màu 
xanh dương 

Lỗi cài đặt plugin Kiểm tra lại file DLL đã copy đúng thư 
mục 
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Trạng thái Nguyên nhân Giải pháp 

Không có dữ liệu Data Source chưa đúng Vào File → Database Settings, kiểm tra 
Data Source là “DataPro.Crypto Plugin” 

Dữ liệu không cập nhật Chế độ Idle Đổi sang chế độ Fast hoặc Normal 

Plugin không hiển thị DLL không tương thích Sử dụng đúng phiên bản DLL (32-bit 
hoặc 64-bit) với AmiBroker 

17.2. Các bước khắc phục cơ bản 

1. Kiểm tra DataPro.Crypto.Client đang chạy 

– Mở Task Manager, tìm process DataPro.Crypto.Client 

– Nếu không có, khởi động lại ứng dụng 

2. Kiểm tra file DLL 

– Đảm bảo file datapro.crypto.dll nằm trong thư mục Plugins 

– Sử dụng đúng phiên bản (32-bit hoặc 64-bit) 

3. Kiểm tra Database Settings 

– Vào File → Database Settings 

– Xác nhận Data Source là DataPro.Crypto Plugin 

4. Reload dữ liệu 

– Click chuột phải vào thanh trạng thái 

– Chọn Reload All 

5. Khởi động lại AmiBroker 

– Đóng AmiBroker hoàn toàn 

– Mở lại AmiBroker 

 

Liên hệ hỗ trợ 

Nếu gặp vấn đề không thể tự giải quyết, vui lòng liên hệ: 

• Hotline/Zalo: 086-832-9247 

• Website: https://datapro.vn 

• Facebook: facebook.com/datapro.vn 
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